
SAP2000 v16.0.0 2013-09-10 Page 1 

SAP2000® (Version 16.0.0) 
Release Notes 

© Copyright Computers and Structures, Inc., 2013 

Notice Date: 2013-09-10 

 

 

This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant and are included in the 

ReadMe file. 

Changes from v15.2.1 (Released 2013-03-08) 

User Interface 
Enhancements Implemented 

* Incident Description 

 35972 Keyboard shortcuts can now be defined by the user for all menu commands. The user customization 

is stored in an XML file that can be edited, and which is saved in the Local App Data folder for 

SAP2000 when the application closes. 
 38175 The Less/More button on the Graphical User Interface that was previously available when the 

analysis was running has been removed. 

 38267 The option to "Add Copy of Property" has been added to the Link/Support Property definition form. 

 49657 The axial (EA) and bending (EI) stiffness modifiers determined by steel frame design using the 

Direct Analysis Method (DAM) of codes "AISC 360-05/IBC2006" and "AISC 360-10" are now 

displayed in the table "Frame Property Modifiers" and on the Assignments tab of the right-click 

form for the properties of line objects. New Open API functions have also been added to get this 

information from the frame object. Previously this information was only available in design tables 

and design details, and this became inaccessible if design had not been performed since the last 

analysis was run, even though it affected the analysis results. The effect of the DAM modifiers was 

already incorporated in the property modifiers displayed in the right-click form for properties of line 

elements when viewing the analysis model, and this has not changed. 
 55513 The graphical working area has been enlarged in the form used for the command View > Set Limits. 

Graphics 
Enhancements Implemented 

* Incident Description 

* 39556 

56948 

The graphical user interface has been improved in terms of responsiveness when using the GDI+ 

graphics mode. Specific items that have been addressed include: (1) The sensitivity to mouse 

movement for 3D rotation has been reduced for more user control. (2) Mouse movements are 

smoother and faster. (3) The speed to refresh the graphics screen has been increased. (4) The speed 

to draw multiple objects using the quick-draw commands is improved. (5) Joints now remain visible 

at all levels of zoom and scale with zoom within the limits specified in the Options. 

 56114 Multiple grid system can now be displayed in the graphical user interface at the same time when 

multiple coordinate/grid systems have been defined. Previously only the grid system associated with 

the current display coordinate system was shown. Now the user can select which grid systems to 

display, and these will all be shown with respect to the current display coordinate system in any 3-D 

view. In addition, the selected grid systems will be displayed in any 2-D view (plan or elevation) for 

those systems with a coplanar grid plane, provided that the Z axis of the grid system is parallel to 

the Z axis of the current display coordinate system. Snapping can be enabled at the intersections of 

grid lines from different grid systems when viewing such a 2-D view. 
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Modeling 
Enhancements Implemented 

* Incident Description 

* 15970 A new link property has been added to represent the triple-pendulum isolator (bearing). This 

bearing has four spherical sliding surfaces that act as three independent friction-pendula in series. 

By adjusting the friction coefficients, radii, and edge stop distances of the sliding surfaces, this 

bearing can produce multiple levels of stiffness and energy dissipation to accommodate a range of 

seismic excitation.  
 28770 

51696 

Tendons have been enhanced to allow the modeling of straight external tendons. Joints of a 

discretized tendon that are not contained within the bounding box of any frame, area, or solid 

element that is a member of the group associated with the tendon will be treated as external if: (1) 

they are not one of the two end joints of the tendon, and (2) the tendon is straight at that joint. Such 

straight external portions of a tendon will normally exhibit constant axial force under analysis. The 

end joints of a tendon will always be connected to the nearest frame, area, or solid element if they 

are not contained within a bounding box. Likewise, interior joints that are not contained within a 

bounding box but are at a curved or kinked region of the tendon will be connected to the nearest 

bounding box. Previously such interior joints were connected to the nearest bounding element 

regardless of whether the tendon was straight or not. 
 30884 New built-in materials have been added for the U.S. standard ASTM A709 (steel) and ASTM A772 

(tendon).  
 46374 Hybrid built-up steel U girders have been added as a new type of frame section property. The shape 

is singly-symmetric. Separate materials may be specified for the top flanges, bottom flange, and 

webs. 

Loading 
Enhancements Implemented 

* Incident Description 

 15751 An enhancement has been implemented to allow fireproofing to now be assigned as a frame load 

included in the structure self-weight, frame object gravity loads, and/or a specified load pattern. The 

fireproofing menu item is now found under Assign > Frame Loads > Fireproofing. 

 36847 

38511 

52905 

The area load assignment "Uniform Load to Frame" has been enhanced to allow exclusion of 

specified frame members from accepting the load transfer from the area objects. This is done using 

a new assignment, Load Transfer Options, for the frame object. The default frame assignment is to 

allow load transfer to the frame object, as was the behavior in previous versions. 

* 43404 Ground-displacement loading assigned to a joint will now act through single-joint links connected 

to that joint and through distributed springs assigned to frames, areas, and solid faces connected to 

that joint. Previously ground displacement loading only acted at joints connected to ground directly 

by joint restraints or joint springs. Now, single-joint links in the object model are converted to two-

joint link elements in the analysis model, with the newly generated joint being fully restrained. 

Ground displacement loading is applied to the generated restraint joint. Similarly, two-joint link 

elements are now automatically generated to represent distributed spring supports for frames, areas, 

and solid faces, and ground displacement loading is interpolated to the generated restraint joints 

from the joints of the parent object. Joint reactions were previously reported at joints connected to 

ground by restraints, springs, and single-joint links, and this has not changed. Similarly, base 

reactions were previously calculated as the sum of the reactions at all joints connected to ground by 

restraints, springs, and single-joint links, and this also has not changed. Older models with ground-

displacement load applied to distributed springs and to joints connected to single-joint links may 

now produce different results than in previous versions. 
 50889 Repeated warning messages that were previously displayed for building heights exceeding certain 

code limits for automated wind loading have been removed and replaced with a single warning 

message. 
* 53533 

 

Automated wind loading has been added according to the Australian and New Zealand code 

AS/NZS 1170.2-2011. 
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* Incident Description 

* 53975 Automated lateral loading has been added according to the IBC 2012 code. This includes seismic 

loads and response-spectrum functions. 
* 53976 Automated response-spectrum functions have been added according to the AASHTO 2012 code. 

* 53977 Automated lateral loading has been implemented according to the Italian NTC 2008 code. This 

includes seismic loads and wind loads. NTC 2008 response-spectrum functions had previously been 

implemented. 
* 53979 Automated lateral loading has been implemented according to the Turkish TSC 2007 code for 

seismic loads and response-spectrum functions, and the TS 498-97 code for wind loads. 

Analysis 
Enhancements Implemented 

* Incident Description 

 16758 The undeformed shape of the structure can now be plotted for staged-construction load cases 

without the need for running the analysis. These plots show the objects that will be present in the 

model at each stage of the analysis. The load-case tree display is used to select the load case and 

stage for plotting. Using this display, load cases that depend on staged construction load cases will 

also show only the active structure in the undeformed shape. 

* 42467 The ability to define multiple mass sources has been added. This does not affect most users. 

Previously there was a single mass source definition that specified whether the mass used for 

analysis should be calculated from elements and additional masses; or from loads present in 

specified load patterns; or both. Now multiple, named specifications of mass source can be defined. 

This could be used, for example, to represent different equipment configurations in a structure or 

different locations of eccentric mass. There is always a default mass source that is used for all 

analyses unless otherwise specified, and this behavior is unchanged from previous versions of the 

software. Now an alternative definition of mass source can be specified to be used for any nonlinear 

static, staged-construction, or nonlinear direct-integration time-history load case. This mass source 

will be used for all other load cases that continue from, or use the stiffness of, that load case. 

Automated lateral loads will be calculated using the mass source specified for the load case in 

which they are assigned. The same lateral load pattern cannot be used with different mass sources, 

so additional lateral load patterns can be defined for use with different mass sources as required. 

The assembled joint mass is reported for each defined mass source actually used in a load that has 

been analyzed. 

 48274 A new type of special-purpose loading, called Load Inertia, is available for response-spectrum and 

Ritz modal analysis. This is not intended for general use. The primary purpose of this loading is to 

capture the vibrational response due to ground displacement, and is intended to be used as part of 

larger specialized procedures such as fault-rupture analysis and multi-support response-spectrum 

analysis. Load-inertia loading references a load pattern and applies an inertial force at each degree 

of freedom that is equal to the product of its mass and the linear static displacement due to that load 

pattern. It is expected that the specified load pattern applies ground displacement loading, but this is 

not required. Response-spectrum cases may apply either standard ground acceleration or load-

inertia loads, but not both. When load-inertia loading is used, the prerequisite modal case must be of 

type Ritz and must apply the same load-inertia loads. 

 49475 Model-Alive has been enhanced to run automatically when the following actions are performed: (1) 

A named property set is added, deleted, or modified. (2) When using the command Analyze > 

Modify Undeformed Geometry. 

 51817 Section-cut results have been enhanced for solid elements that are auto-meshed. Previously, for 

section-cuts defined by a group, the forces from meshed elements of a solid object in the section-cut 

group were only included in the section-cut if the elements connected to the edge of the parent 

object and both joints on that edge were included in the section-cut group. This has been extended 

to include elements that connect to the face of the parent object if all four joints on that face are 

included in the section-cut group. Section-cuts defined by quadrilaterals are not affected, since they 

include all elements that are cut by the quadrilateral, which may or may not be on the edge or face 

of the parent solid object. 
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* Incident Description 

 57365 The conjugate-displacement method of displacement control for nonlinear static load cases has been 

simplified. The basic conjugate displacement is calculated as the weighted average of all 

displacements in the structure, with each displacement degree of freedom being weighted by the 

load acting on that degree of freedom. Previously the direction of loading (positive or negative) was 

also being adjusted in an adaptive manner such that the largest change in hinge deformation at each 

loading step was monotonic. However, this latter consideration of hinge deformations sometimes 

gave unexpected oscillatory results, and so it has been removed. Now only the basic conjugate 

displacement is being used when this method is selected. The monitored-displacement method of 

displacement control has not been changed. 

* 57640 A change has been made to how negative values are processed when generating mass from the mass 

source. All mass from materials, properties, and added mass are always positive, except joint mass 

which may be positive or negative. Mass generated from loads, when requested, is positive when 

the loads are downward (-Z), and negative when the loads are upward (+Z). Previously, the positive 

and negative contributions to mass were summed for each individual element and set to zero if 

negative. This was done before adding the contribution of the element mass to the structure. Now, 

instead, positive and negative values from each element will be retained, assembled for the 

structure, and reported in the database table "Assembled Joint Mass". During equation solution, if 

any negative values are detected after accounting for constraints, they will be set to zero and a 

warning will be printed in the analysis log file. Most users and most models will be unaffected by 

this change. However, the results may differ from previous versions in cases where significant 

upward loads were included in the mass source. The purpose of this enhancement is to enable users 

with special needs to change the mass distribution in a model, such as for investigating the effect of 

eccentric story mass on mode shapes. See also Incident 42467 for multiple mass sources. 

 
Frame Design 

Enhancements Implemented 
* Incident Description 

 35596 An enhancement has been implemented for all frame design codes where design values are now 

displayed onscreen even for members that are overstressed. Previously the expression "(O/S)" was 

displayed instead of the design values for overstressed members. Now the expression "(O/S)" is 

shown in addition to the design values, so that both can be viewed. 

 36797 An enhancement was made for steel frame design using the EC 3-2005 code where the design 

output has been improved to provide a better representation of the governing equation. It now 

displays PMM ratios with component ratios with appropriate sign and formula. 
 39480 Concrete frame design using the Eurocode 2-2004 code has been enhanced to now check the 

beam/column (B/C) capacity ratio for DCM_MRF for seismic design of concrete frames. Previously 

the B/C capacity ratio was only being checked for DCH_MRF concrete frames. Note that for 

Eurocode 3-2005 steel frame design, the B/C capacity ratio was being checked for both DCM_MRF 

and DCH_MRF steel frames. 

 42786 Seismic design for concrete frames according to Eurocode 2-2004 and for steel frames according to 

Eurocode 3-2005 has been enhanced by implementing the Eurocode 8:2004 exception clause (6) of 

4.4.2.3, which allows not checking the beam/column capacity ratio for joints at the top story. 

Previously the beam/column capacity ratio was checked for all beam/column joints. Now this check 

is omitted for any beam/column joint that has no column connected from above. 
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* Incident Description 

* 43712 The specified concrete strength as used for Chinese materials and design codes has been changed to 

refer to the characteristic strength, whereas in SAP2000 v15 and earlier versions the concrete 

strength referred to the grade. The built-in Chinese concrete materials have been changed 

accordingly, and so have the concrete frame design checks. For example, the Chinese material C30 

previously specified the strength as 30 N/mm^2, but now specifies the strength as 20.1 N/mm^2. 

Models created in v15 and prior versions that are opened in v16 will have the concrete strength of 

ALL concrete materials converted from grade to characteristic strength if the concrete frame design 

preference in the older model specifies the Chinese code. This should have no effect on the results 

between versions for Chinese design. Users should review the concrete materials carefully when 

first opening a model from an older version in v16 if the concrete frame design was set to use the 

Chinese code. 
 49319 An enhancement has been implemented for steel frame design where more detailed section 

properties are being reported for L-shaped sections. These properties include Imax, Imin, Smax, 

Smin, rmax, rmin, Ixy, and the principal rotation angle. The affected design codes are: AISC 360-

10, AISC 360-05, EC 3-2005, Italian NTC 2008, Indian IS 800:2007, and NZS 3404-1997. 

 51779 Steel frame design using code "AISC-ASD89" has been enhanced to allow additional control over 

the calculation of the Cm and Cb factors so that the effects of small lateral loads can be ignored. 

This control is available in the Design preferences, where the options are described. In addition, 

separate lateral load factors can now be specified for seismic and wind loads, where previously the 

same factor was used for both types of loads. The actual lateral load factor used for each design load 

combination is provided in the detailed results. 

* 53426 Steel frame design has been implemented according to the American "AISC 360-10" code, 

including the seismic provisions of the AISC 341-10 code. 

* 53431 Steel frame design has been implemented according to the Italian "Italian NTC 2008" code (“Norme 

Tecniche per le Costruzioni - D.M. 14 gennaio 2008”). 

* 53432 Concrete frame design has been implemented according to the American "ACI 318-11" code. 

* 53434 Concrete Frame Design has been implemented according to the Italian "NTC 2008" code (“Norme 

Tecniche per le Costruzioni - D.M. 14 gennaio 2008”). 
* 53438 Concrete frame design has been implemented according to the Mexican "RCDF 2004" code 

("Technical Norms for Design and Construction of Concrete structures, October 06, 2004"). 

* 53439 Concrete frame design has been implemented according to the New Zealand “NZS 3101-06” code 

("The New Zealand Standard NZS 3101-06"). 

* 54805 Two new verification suites have been added, one for concrete frame design and one for steel frame 

design. Each suite consists of a set of example problems covering the various supported codes, and 

includes documentation, model files, and an Excel spreadsheet to automate the running and 

checking of the models. The two new suites are similar to the existing analysis verification suite. 
 56358 Concrete frame design using the TS 500-2000 code has been enhanced for the seismic shear design 

of beams so that now gravity shear force is computed for the simply supported condition. Previously 

the gravity shear values were obtained directly from the analysis where the beams could be 

continuous. 
* 56949 Concrete Frame design has been added according to Hong Kong CP 2013 code. 

 57718 The AS 3600-09/NZS 3101-06 codes for concrete frame design and the AS 4100-1998/NZS 3404-

1997 codes for steel frame design have been updated for lateral load combinations by incorporating 

Amendment No. 3 in 2011 where the combination load factors for live load combined with seismic 

loads has changed from 0.4 to 0.3. 
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Results Display & Output 
Enhancements Implemented 

* Incident Description 

 17362 

38619 

Analysis results for staged-construction load cases are now identified by a step label and the step 

number. The step label includes the name or number of the stage, the step number within the stage, 

and the age of the structure for time-dependent load cases. The step label is shown in the window 

title for plotted results, as a new column in the database tables, and is available through the new 

Open API function SapModel.Results.StepLabel. 

 32598 Plotting of tendon forces and losses has been enhanced as follows: (1) When defining a tendon 

object, the distribution of axial force or stress along the length of the tendon may be plotted for each 

load pattern, showing the values before seating, after seating, and after other losses. (2) After 

running the analysis, for tendons modeled as elements, the force or stress response can be plotted 

for any load case and compared with the previous plots for the load pattern. The response from the 

analysis load case inherently includes all losses. 
* 37440 

38265 

38376 

Stress output for frame members has been enhanced to include shear stresses S12 and S13, the 

principal stresses Smax and Smin, and the von Mises stress SVM. These stresses are available for 

certain thin-walled sections, as well as for rectangular and circular sections. Section Designer 

sections can produce stresses as defined by the user. Stresses can be plotted and are available in 

tabular form. 
 39265 

42340 

44910 

When displaying frame forces or stresses and then right-clicking on a frame member to view 

detailed results, a red dot is now shown on the frame object in the model window to show the 

location within the member corresponding to the cursor when scrolling over the detailed force, 

moment, or stress diagrams. This feature was previously available in v14 but not in v15. 

 55512 An option has been added when displaying Frame Design D/C ratios onscreen that allows the user 

to specify a threshold value above which the ratios are shown, making it easier to identify the 

critical members. This option also allows the members above the specified threshold to be selected, 

providing further control of display, tabular output, or assignment of design overwrites. 

* 56115 A new option has been added to display the bearing pressure acting on area (shell) objects as 

calculated by analysis due to the presence of area springs assigned to the top and/or bottom faces of 

the objects. 

 56116 An option has been added for the display of stress contours and stress arrows for shell objects to 

show the stresses normalized with respect to material strength. This strength used for this purpose is 

the yield strength (Fy) for steel, cold-formed steel, rebar, and tendon materials; the minimum yield 

strength (Fcy or Fty) for aluminum materials; and the compressive strength (f'c) for concrete 

materials. Zero stresses are plotted for other materials. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 35774 Unused bridge-related items from the Bridge Module of earlier versions have been removed from 

the database tables. 

Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 27983 

43587 

New Open API functions have been added to set and get the definition of sections cuts, as described 

in the CSI_OAPI_Documentation Help file under topic CSi OAPI Functions > Definitions > 

Section Cuts. Open API functions to get section-cut results were already available. 
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* Incident Description 

* 47723 A new type of load case, "External Results", has been added. This type of load case, while visible in 

the graphical user interface, must be defined using Open API functions. Using Open API functions, 

internal forces and moments determined from an external source can be specified for each frame 

element in the model for External Results load cases. These load cases can be added to load 

combinations and used for frame design like any other load case. All other response quantities 

(displacements, reactions, shell stresses, etc.) will be reported as zero for these load cases. 

 51368 The Open API function SapModel.AreaObj.SetGroupAssign has been enhanced so that it now can 

be used even when the model is locked. Previously this function only worked when the model was 

unlocked. 

* 52267 Two new Open API (OAPI) functions have been added to obtain the steel-frame design results 

corresponding to the design database tables for certain codes as documented in the OAPI help file. 

These functions are SapModel.DesignSteel.GetDetailResultsText and 

SapModel.DesignSteel.GetDetailResultsValue. Functions for obtaining summary results were 

already available. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

* 16069 

24529 

30038 

42087 

45305 

49074 

51454 

55670 

55997 

The export and import of IFC files has been enhanced and corrected as follows: (1) IFC 4 format is 

now supported. IFC 2x3 files can still be imported and exported. (2) Several IFC entities that 

previously were not imported or were not imported correctly can now be imported. See the IFC 

Import Export Technical Note for supported entities. (3) The exported file now has an .ifc 

extension. Previously it was given a .stp extension. (4) Exported GUIDs of SAP 2000 objects are 

now consistent with their internally stored GUIDs. In the case of models converted from earlier 

versions of SAP 2000 in which there are no internally stored GUIDs, the assigned GUIDs are stored 

when the SAP2000 model is saved. (5) Pipe and circular sections were previously exported to IFC 

with a diameter twice their actual diameter. In addition, pipe sections were not being exported as 

hollow sections. These issues have been corrected. (6) Files can be exported either as a “structural 

analysis view” or an “architectural coordination view”. Previously only the “architectural 

coordination view” was available. Both can be imported, as before. (7) Options are now provided on 

export and import to select the types of objects to process. 
 33274 For the import of CIS/2 Step data files, the warning message that is provided when no supported 

entities are found has been improved to indicate that an analytical model is required for import. 

 56151 The export and import of Revit Structure .exr files has been enhanced and corrected as follows: (1) 

SAP2000 frame joint offsets, which previously were not being exported to Revit Structure, are now 

exported. (2) Revit Structure rigid links, which previously were not being imported into SAP2000, 

are now imported (3) Vertical shells with their bottom two points at different z elevations, which 

were previously exported to Revit Structure as walls with a sloping base, are no longer exported to 

Revit Structure because their import into Revit Structure caused a serious error in Revit Structure 

that terminated the import. (4) Nearly vertical shells are no longer exported to Revit Structure 

because they were previously being incorrectly interpreted by Revit Structure. (5) Round bar and 

plate frame object sections can now be imported from Revit Structure. 

 56600 The import of STAAD data files has been enhanced to now import reference and notional loads as 

SAP2000 load patterns. 

Documentation  
Enhancements Implemented 

* Incident Description 

 15676 Documentation has been added to the Automated Lateral Loads Manual for the seismic load, wind 

load, and response-spectrum function provided for the Indian codes. The functionality was already 

present in the program, only the documentation has been updated. 
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* Incident Description 

 31689 The "CSI Analysis Reference Manual" has been updated to document that it is possible to create 

degenerate solid elements, such as wedges and tetrahedra, by collapsing various sides of the 

element, i.e., by connecting adjacent corners of the 8-node element to the same joints in the model. 

This is a change to the documentation only, not to the behavior of the software. 

 39306 The context sensitive help was updated to reflect a previous enhancement to the definition of 

material properties, which allows new materials to be added based upon a region, material type, 

standard, and grade. 

 41571 The definition of Tcon was added to the Concrete Frame Design manual for Eurocode 2-2004 

according to Eurocode section (EC2 6.3.2(5)). This was a documentation omission only, and no 

results were affected. 
 47518 The online Help topic for the "Set Display Options" command has been updated to describe how 

these options are used and how to use the "Show Undeformed Shape" command (F4 key) to return 

any view back to the settings selected on the "Set Display Options" form. 

Installation & License 
Enhancements Implemented 

* Incident Description 

* 41626 Licensing has been upgraded to the latest SafeNet version, providing support for virtual servers, and 

allowing more flexibility for using commuter licenses. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 41648 The version number has been changed to v16.0.0 for a new major release. 

 47055 An enhancement has been made to the analysis verification Excel spreadsheet to allow it to be used 

on 64-bit versions of Microsoft Excel. 

 

 

 

User Interface and Display 
Incidents Resolved 

* Incident Description 

 36783 An incident was resolved where an error message is generated when trying to delete all analysis 

results on the Set Load Cases to Run form when the results were not actually present. No results 

were affected. 

 39688 

39728 

43334 

44145 

An incident was resolved where the toolbar button for the command Display > Show 

Forces/Stresses > Links was not properly enabled when the menu command was available. No 

results are affected. 

 39772 An incident was resolved where the units selected by the user on the main interface windows were 

being reset to the model database units after viewing design results. This was an inconvenience. No 

results were affected. 

 39834 

49503 

An incident was resolved that corrected minor issues with the Graphical User Interface: (1) The tool 

buttons Merge Points, Show Joints, Show Frames, and Show Shells did not work and/or did not 

remain depressed when used. (2) Frame end releases were not shown in the proper location for 

inclined members when using in DirectX graphics mode. (3) Moving model windows around or 

changing their size could generate error messages. 
 40166 An incident was resolved where an error message was generated when clicking in a graphics 

window after using the command File > Report Setup if that graphical window had the model 

displayed with the Object Shrink Toggle turned on. No results were affected 
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* Incident Description 

 40358 An incident has been resolved where assigning wind pressure coefficients to area objects using 

Loads tab of the right-click Area Information form did not work, i.e., the specified value was not 

assigned. Results were consistent with the model. Other methods of assigning these coefficients did 

work, including using the Assign menu and Interactive Database Editing. 

 42518 An incident was resolved where an exception (runtime error) was sometimes generated in the 

graphical user interface when selecting a large number of link objects. No results were affected. 

 42643 An incident was resolved where the graphical user interface would become sluggish or could 

generate the error message "Running out of memory" in models with a very large number of link 

objects when the link objects were being displayed. No results were affected. 

 44760 An incident was resolved where the tool buttons for 2D views (xy, xz, yz, rt, rz, tz) were 

inconsistently enabled or disabled when switching between cartesian and cylindrical coordinate 

systems. Now all six buttons are enabled each time SAP2000 is started. During the session, any of 

the six buttons can be enabled or disabled. Which buttons are displayed depends on whether the grid 

system associated with the current coordinate system (as selected by the user in the lower-right 

corner of the GUI) is cartesian or cylindrical, independent of which grid systems are being 

displayed. 

 50300 An incident was resolved where editing the joint connectivity of an area abject from the Location 

tab on the right-click object properties form could generate a runtime error that would terminate the 

application. No results were affected. 

 50975 An incident was resolved in which a runtime error was generated when switching the spectrum type 

of an existing NTC 2008 response spectrum function definition from elastic to design. This was a 

user interface error only and did not affect results. 

 52256 An incident was resolved where the tool button "Merge Points" did not work, even when the 

equivalent menu command was available. No results were affected. 

 54376 An incident was resolved for steel frame design using the Eurocode 3-2005 code where the design 

overwrite form did not provide the option to reset the Buckling Curves options (y-y, z-z, LTB) and 

Section Class option to "Program Determined" after a user-defined option was chosen. 

 55967 An incident was resolved where the conversion for units was not always correct when editing 

coordinate data on the Tendon Data Form. 

Graphics 
Incidents Resolved 

* Incident Description 

 24101 An incident was resolved where a portion of the model was not printed when using the command 

File > Print Graphics and the display on the screen was showing bounding boxes. No results were 

affected. 

 25782 

50137 

An incident was resolved where the display option to view objects by the color of the material did 

not account for material overwrites that may have been assigned to frame, cable, and area objects. 

No results were affected. 
 27268 An incident was resolved where end offsets for a nonprismatic column object did not appear to plot 

correctly in an extruded view. In general, end offsets are not shown for column objects in the 

extruded view unless the display of the end-offset assignments is explicitly requested. However, 

when the end-offset assignments were not requested, the extruded view for nonprismatic sections 

was incorrectly showing the sum of the I-offset and J-end offset at the J end. No results were 

affected. 
 38339 An incident was resolved where the extruded view of the double-channel and double-angle frame 

sections was not correct in the undeformed and deformed shapes. Results were not affected. 
 38969 

44579 

46649 

An incident was resolved where the animation of displaced shapes using GDI+ graphics may be 

irregular in motion or not animate at all for certain displaced shapes (animation of displaced shape 

is not available for DirectX graphics). Results are not affected. 
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* Incident Description 

 40670 An incident was resolved where the extruded view could fail to display for certain models 

containing area objects with shell overwrites for thickness or joint offset. Results were unaffected. 

For models created in versions prior to v16, it may be necessary to save the model after first 

opening it in v16 to clear the condition that caused this display issue. 
 41134 

47364 

An incident was resolved where using the command View > Set Limits had no effect on the display 

of solid elements. No results were affected. 

 42027 

45017 

46391 

48092 

52054 

52235 

52389 

53407 

An incident was resolved where user-defined developed elevations were not being properly saved in 

the model file and were not available or correct when the model is re-opened. No results were 

affected. 

 45256 An incident was resolved where the named color schemes were not being saved in the SAP2000.ini 

file for use in the next session, even though customized color schemes were being saved. No results 

were affected. 

 47084 An incident has been resolved where an error message may be generated when performing selection 

using the mouse on a shell model with the option snap-to-intersections turned on. No results are 

affected. 

 47091 

52312 

An incident was resolved where the toolbar button for the command Display > Show Plot Functions 

was only available for time-history load cases, whereas it should have been available for any multi-

step load case. No results were affected. 

 52144 An incident was resolved where the blue plane displayed in 3-D graphical views when a 2-D view is 

active was not consistently visible. No results were affected. 

 54754 An incident was resolved where the wave plot showing the water line and mud line in 2-D views 

when displaying wave forces that was previously available in v14 was not available in v15. This has 

been restored. No results were affected. 
 55118 An incident was resolved where the extruded view of certain frame sections did not properly outline 

the edges and ends of the section. This was a display issue, and no results were affected. 

Drafting 
Incidents Resolved 

* Incident Description 

 37629 An incident has been resolved where the command Select > Coordinate Specification > Coordinate 

Range did not account for the CSYS origin offset when using a coordinate system other than 

GLOBAL. 

 42433 An incident has been resolved where link objects (one- and two-joint) could be drawn without any 

property assigned to them if the option to Show Floating Property Window had been turned off. 

When this occurred, corresponding link elements were not present in the analysis model. 

 42597 An incident was resolved where the edit command to Divide Areas using visible grids would not 

work if only one Z grid was present. Results were unaffected. 

Modeling 
Incidents Resolved 

* Incident Description 

 41900 An incident has been resolved where the backbone curve calculated for FEMA 356 concrete beam 

and column flexural hinges using Tables 6-7 and 6-8 may have been based on an incorrect value of 

V / (bw * d * sqr(f'c)) ratio, depending on units being used. When calculating the ratio, all items in 

the ratio were converted to lb and inch units except for V which was in the database units for the 

model. Thus if the database force units were lbs the ratio was being calculated correctly. 
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* Incident Description 

 52216 An incident was resolved where the assignment of advanced local axes to a joint using the 

cylindrical or spherical directions CA, CR, SA, SB, or SR did not always produce the correct axis 

orientations when the directions were referenced to a coordinate system other than the Global 

system. The error was obvious when displaying the joint local axes. 

Section Designer 
Incidents Resolved 

* Incident Description 

 37518 An incident was resolved for Section Designer in which, for a Caltrans section with non-zero force 

prestress tendons, if the tendons were located such that the prestress forces result in nearly zero 

initial curvature for the section, sometimes the prestress forces might not be considered in moment 

curvature curve calculation or failed to calculate the moment curvature curve. This error was 

corrected for versions 15.2.0 and later, but was inadvertently omitted from the Release Notes. 

* 39070 An incident has been resolved for Section Designer in which very small overlaps between two 

shapes could cause the incorrect calculation of the section properties, depending on the angle of 

rotation of the section. This error was very rare. 

 39927 

44149 

An incident was resolved for Section Designer where an error message was generated when right-

clicking on a shape with rebar for which the edge rebar had been previously set to "None" and 

trying to view the rebar material curve. The affected shapes were rectangular solid, polygon, and the 

rectangular rebar pattern. This error message affected the right-click operation only. No results were 

affected. 

 40214 An incident was resolved where the design-code P-M-M interaction surface displayed in Section 

Designer for concrete sections did not account for the values of reduction factors (such as phi or 

gamma) specified in the Design Preferences for the following concrete frame codes: "AS 3600-09", 

"AS 3600-01", "Eurocode 2-2004", and "TS 500-2000". Instead, default values were always being 

used for this display. Other design codes were not affected. This was a display issue only and only 

in Section Designer. It did not affect any design results or the P-M-M surface displayed with the 

design results, all of which were correctly using the values specified in the Design Preferences. 

 40842 An incident was resolved for Section Designer in which, when defining a Caltrans Section, the 

confinement bar number (Conf. Bar No.) could not be set to any value other than W20 if the 

confinement type (Conf. Type) was set to wire "Wire". In addition, it was not possible to change the 

bar number (wire size) in the database tables when the confinement type was set to "Wire". 

 42665 An incident was resolved for Section Designer where the volumetric ratio of transverse confinement 

steel to the concrete core was reported incorrectly in the summary report obtained when viewing the 

Mander concrete stress-strain curve. It was instead reporting the value of the main column steel 

ratio. This was a reporting error only and did not affect any results. 

 45243 An incident was resolved for Section Designer where the Sector and Segment shapes (portions of a 

circle) could not be used for any material other than concrete. No results were affected. 

 47558 An incident has been resolved for Section Designer where an exception (run-time error) was 

generated when assigning a concrete material to a shape if that concrete material was defined with 

the strain at f'c less than or equal to f'c/E, where f'c is the concrete strength and E is the modulus of 

elasticity. Similarly, shapes could sometimes not be drawn in Section Designer if such a concrete 

material was defined. No results were affected. 
 50051 An incident was resolved for Section Designer where the fibers generated for the built-in channel 

section did not have the correct location or area. This could affect the behavior of fiber hinges 

generated from such a section. This error was obvious when viewing the fibers in Section Designer. 

 50105 An incident was resolved where the discretization of circular shapes for the purpose of calculating 

the areas assigned to fibers could omit a small fraction of the area, particularly for more refined 

fiber meshes. This error did not affect the calculation of section properties, PMM surfaces, and 

moment-curvature relationships that were not based on fibers. Design results do not use fibers and 

were not affected. The error was obvious when comparing the displayed area for fibers vs. the fully 

integrated area. 
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* Incident Description 

 52187 An incident was resolved for Section Designer where the Caltrans idealized moment-curvature 

relationship was not correctly displayed when requested for tensile or small compressive axial force 

when the ultimate strain capacity for the rebar material was set to a small enough value so that the 

rebar failed before the concrete reaches the "yield" strain of 0.003. This was a display issue only and 

did not occur if the idealized moment-curvature relationship was previously displayed for a large 

enough compressive axial force to cause concrete yield to occur before rebar failure. Caltrans auto-

hinge properties generated for such a Section Designer section were not affected. 

* 52384 An incident was resolved for Section Designer where the plastic modulus for a section with multiple 

materials was computed using transformed areas based on the Young's moduli of the different 

materials rather than based on the yield strengths. The plastic modulus has no effect on analysis 

results but could affect steel-frame design results for the rare case where a steel Section-Designer 

section uses mixed materials.  

 55211 An incident was resolved for Section Designer where the calculation of the moments of inertia (I22, 

I33, I23) and the section moduli (S22, S23) were incorrect for the double-angle structural shape 

when the shape was rotated in Section Designer by an angle other than zero. This also affected other 

structural shapes (but not solids and polygons) that were rotated if they were partially covered by 

another shape. This error only affected the rotation of the shapes within Section Designer, not the 

rotation of the section as a whole for a frame object. 

Loading 
Incidents Resolved 

* Incident Description 

 50848 An incident was resolved for auto-seismic loading according to Eurocode 8-2004 using the lateral 

load method with approximated Ct factor for period calculation. The Ct factor shown in the table 

"Auto Seismic - Eurocode8 2004" was always given as 0.035, regardless of the value specified in 

the load pattern. This was only a reporting issue; the correct value of Ct was used for calculating the 

period. 

 51147 An incident was resolved where duplicated seismic load combinations were being generated for 

Chinese design when the vertical seismic load was zero. Now the load combinations that contain 

vertical seismic load will not be generated when that load does not exist. Results were unaffected 

since the duplicate combinations were valid. 

 54011 An incident was resolved where the Wave loading using Stokes 5th-order solution was using an 

incorrect sign on a higher order term. See discussion in Section 2.10 of "Non-linear Waves", by 

Michael Brorsen. http://vbn.aau.dk/ws/files/17183675/Non-linear Waves . 

 56625 An incident was resolved for the Chinese 2010 response spectrum definition in which the response 

spectrum curve was not generated  when the characteristic period Tg was small. 

Analysis 
Incidents Resolved 

* Incident Description 

 41810 

53919 

54856 

An incident was resolved where the hysteresis loop for uncoupled frame hinges (P, M3, etc.) using 

the pivot model was always using the default pivot parameters (alpha = beta = 1, eta = 0) instead of 

the values specified by the user. The error was obvious by looking as the hysteresis response. 

 43562 An incident was resolved where memory usage sometimes increased gradually during direct-

integration time-history analysis, possibly leading to an out-of-memory error before the analysis 

completed. No results were affected for load cases or parts of load cases that had run. 
 44414 An incident was resolved where link deformation response for moving load cases was reported as 

zero in certain cases due to a tolerance used to determine zero influence lines. This was more likely 

to affect models using mm and inch length units. When this occurred, the error was obvious because 

it was identically zero. In rare cases other types of response could be affected, although this has not 

been reported. 
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* Incident Description 

* 53144 An incident was resolved where two issues were corrected for the channel frame section property: 

(1) The Shear Center Eccentricity displayed in the Property Data form when defining the channel 

section property is intended to be the distance from the centroid to the shear center, but the value 

displayed and used for analysis was the smaller distance from the nearest face of the channel to the 

shear center. This same value is shown in the database table "Frame Section Properties 01 - 

General" as "EccV2". This has been corrected so that the value displayed and used is the distance 

from the centroid to the shear center. When this value is zero, there is no coupling between shear 

and torsion. (2) The shear and torsional internal frame response was previously defined at the 

centroid of the section. This has been changed to be defined at the shear center of the section. Only 

versions 15.2.0 and v15.2.1 were affected. See also Incident 53819. 

 53342 An incident was resolved where the use of modal damping interpolated by period in a response-

spectrum or modal time-history load case was actually using interpolation by frequency between the 

specified values. This means that the damping values were correct at the specified period values, but 

the interpolation between the specified values was proportional to f = 1/T, rather than to T. Here T 

is period and f is cyclic frequency. The effect of this error upon the results was generally 

insignificant. 

 53750 An incident was resolved where groups containing area objects that were auto-meshed and that also 

had edge constraints assigned did not always include the effect of the edge constraints when used in 

a nonlinear static staged-construction load case. This could have affected the local connectivity of 

the area objects, but overall equilibrium was maintained. 

* 53819 An incident was resolved where the fixed-end forces and moments calculated for a frame element 

having a channel section property and subjected to concentrated or distributed span loads acting in 

the element local 2 direction were incorrectly distributed to the two ends. Distributed span loads 

include the self-weight of the member. The resultant of these forces and moments were in 

equilibrium with the applied load, so the effect on the structure was localized. When the span loads 

were part of a load pattern used in the mass source, this could result in the incorrect mass being 

calculated for the frame element. The effect of this error was more significant for shorter elements, 

and was caused by calculations related to the shear center of the channel section. Only version 

15.2.1 was affected. See also Incident 53144. 

* 53854 An incident was resolved where joint patterns used to assign thickness and/or offset overwrites to 

shell-type area objects were not being properly applied in the following two cases: (1) If the 

analysis was run out-of-process, the joint pattern values were ignored (set to unity) for calculating 

shell element stiffness, mass, loads, and the force/stress response. (2) If the analysis was run in-

GUI-process, the joint pattern values were correctly used for calculating shell element stiffness, 

mass, and loads. The joint patterns were also correctly used for displaying the force/stress response 

after running the analysis, but were ignored (set to unity) for results displayed or exported in tables, 

and for all force/stress response displayed after the model was closed and reopened without re-

running the analysis in-GUI-process. For analyses run out-of-process, the effect on the stiffness, 

mass, and loads could affect the analysis results of the entire model. For analyses run in-GUI-

process, the displacement/force/stress response of the entire model was correct except for the 

force/stress response of only the shell elements using joint patterns for thickness and/or offset 

overwrites. For the common case of shell thickness and/or offset overwrite assignments that do not 

reference joint patterns, the results were correct.  
* 54046 An incident was resolved where an angle section property imported from a property database file 

could, in certain cases, use an incorrect value for the cross-inertia term I23 if a user-specified 

section property with non-zero I23 was defined before the imported property. When this occurred, 

the imported property took on the value of I23 from the most recently defined section-property with 

non-zero I23. The actual values of I23 used for each section property can be seen from the table 

"Frame Section Properties 01 - General" after running the analysis. This error was not common. 

Only single-angle sections were affected. Only versions 15.2.0 and v15.2.1 were affected. Prior 

versions did not use I23 for analysis. 
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* Incident Description 

 54346 An incident was resolved where the operation Change Section applied to a frame or shell object in a 

stage with non-zero duration of a staged-construction load case had the effect of removing creep 

and/or shrinkage strain from that object for that stage. It is expected for the Change Section 

operation to remove time-dependent strain for previous stages, but not for the same stage. Now for a 

given object in a given stage, the Change Section operation is applied first, followed by loading, 

followed by time-dependent strain as expected. 

 54395 An incident was resolved where an instability could be generated in a model having a nonprismatic 

frame section for which the cross moment of inertia, I23, changed sign within a segment of the 

section. When this occurred, the frame forces were not available or the error was obvious from the 

large magnitude of the analysis results. Now the cross moment of inertia will be ignored within any 

segment of a nonprismatic frame section where its sign changes. This approximation will have little 

effect on the results, and can be minimized by further discretizing the nonprismatic section property. 

Affected sections could include angles, general sections, and Section Designer sections. Only 

versions v15.2.0 and v15.2.1 are affected. The cross moment of inertia was not included in analysis 

for earlier versions. 

Frame Design 
Incidents Resolved 

* Incident Description 

 32917 

41953 

An incident has been resolved where the orientation of the local-3 axis was reversed in the plot of 

the frame section shown on the design detail display sheet. This was a display issue only, and had 

no effect on the design results. 

 39341 An incident was resolved for steel frame design using the Eurocode 3-2005 and Indian IS 800:2007 

code where an error message was generated while checking tubular sections when (1) the section 

had a very small cross-sectional area such that N.Ed >= N.pl.Rd and (2) either the major- or the 

minor-axis bending moment was identically zero. The error was obvious when it occurred. 

 40092 An incident was resolved for steel frame design using the AISC 360-05 code where the shear 

capacity was not being multiplied by the Phi factor when Pr/Py was less than or equal to 0.15 for 

EBF (eccentrically-braced-frame) link beams. The error was obvious because the capacity being 

used was reported. This affected versions 11.0.0 to 15.2.1. 
 41908 An incident has been resolved for concrete frame design using the Eurocode 2-2004 code where the 

Design Overwrites form allowed the following extraneous parameters that were not being used: 

Moment coefficients Cm Major and Cm Minor, NonSway Moment Factors Dns Major and Dns 

Minor, and Sway Moment Factors Ds Major and Ds Minor. These parameters were not documented 

and were not being used for design. No results were affected. These parameters have now been 

removed. 

 41950 An incident was resolved for concrete frame design using the Eurocode 2-2004 code where the 

design detail results were incorrectly reporting a load combination containing seismic load as being 

non-seismic when the axial force in the member was tensile. In this case, the reporting of 

compression capacity check was omitted. However, the compression capacity is not relevant in such 

a case. This was a reporting issue only. All design checks were correct, and no results were affected. 
 42782 An incident has been resolved for steel frame design using the Eurocode 3-2005 code where the 

error message "Ned > Ncr,T" was sometimes shown when in fact the controlling case was Ned > 

Ncr, where Ncr is the smaller of Ncr,T and Ncr,TF. The controlling condition was being correctly 

detected and only the displayed message was incorrect. Now the message will display as "Ned > 

min(Ncr.T, Ncr.TF)". 
 43690 

44101 

48276 

48278 

57435 

An incident has been resolved for steel frame design using the Eurocode EC 3-2005 code in which 

the Euler flexural buckling capacities Ncr.y and Ncr.z for L-shaped sections were being calculated 

based on moment of inertia about the geometric axes instead of the principal axes. Now the Ncr.y 

and Ncr.z are calculated based on moment of inertia about the principal axes. The previous capacity 

was conservative in one direction and unconservative in the other. 
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* Incident Description 

 44111 An incident was resolved for concrete frame design where a Section Designer error message was 

generated when designing any section (even if not a Section Designer section) whose concrete 

material was defined with the strain at f'c less than or equal to f'c/E, where f'c is the concrete 

strength and E is the modulus of elasticity. When this occurred the application terminated and no 

design results were available. 
 45383 An incident was resolved for steel frame design using the Eurocode 3-2005 code where the design 

overwrites form provided an option for overwriting Nc.Rd but the program did not use the 

overwritten values. Now the program uses the overwritten values for NRd for compression in EC3 

6.2.1(7), Nc.Rd in EC3 6.2.4, Npl.Rd for compression in EC3 6.2.9.1, Aeff*fy/GammaM0 for 

compression in EC3 6.2.9.3(2), A*fy/GammaM1 for compression in EC3 6.3.1.1, and 

NRk/GammaM1 for compression in EC3 6.3.3. Similarly the overwritten value for Nt.Rd is used for 

NRd for tension in EC3 6.2.1(7), Nt.Rd in EC3 6.2.3(1), and Npl.Rd for tension in EC3 6.2.9.1. The 

axial term NEd/NRk is ignored for tension in EC3 6.3.3.  

 45812 An incident has been resolved where the command Design > Lateral Bracing could not be used to 

reset the lateral bracing back to "Program Determined" (no lateral bracing) once user-defined 

bracing had been specified for a given member. The values of effective length actually being used 

for minor bending and lateral torsional buckling were being correctly reported and the design results 

produced were consistent with these values. 

 47047 An incident was resolved for steel frame design using the Eurocode 3-2005 code where the design 

was not checking interaction equations EC3 6.2.3-Eq 6.5 and EC 6.3.1.1-Eq 6.46. The interaction 

equations EC3 6.3.3 that were being checked did not cover the extreme cases when Ae/An << 1 or 

when the torsional buckling mode governed the axial capacity. This error could be unconservative 

in such cases. Now the design considers these two additional equations explicitly as well as EC3 

6.3.3. 

 48083 An incident was resolved for steel frame design using the "AISC 360-05", "AISC LRFD 1993", 

"AISC LRFD 1999", and "AISC UBC 1997" codes where all T-sections were being classified as 

Seismically Not Compact even when that was not true. The error was obvious and conservative. 

 50920 An incident was resolved where steel frame design for T-shaped section was incorrect for 

CAN/CSA S16-01 code when design moment was negative. Program was not correctly enforcing 

the lateral torsion buckling capacity. The bending capacity for positive moment was correct. 

* 51148 An incident was resolved where the frame design (steel, concrete, aluminum, cold-formed) would 

not consider a multi-valued load case in a design combination if step-by-step results were requested 

but the particular case was not the last case in the combination. When this error occurred, the 

contribution of the affected load case to the load combination was zero. This error did not occur if 

enveloping results were requested or the case was not multivalued or the case was the last one in the 

combination list. 

 51831 An incident was resolved for concrete frame design where, on rare occasions, an over-stressed (OS) 

condition was reported when the design moment was very close to but not exactly equal to zero. 

This could occur due to a numerical tolerance problem. This was a rare problem and was over-

conservative when it occurred. 

 52581 An incident has been resolved for steel frame design using the AS 4100-1998 code where the 

calculations have been refined for the effective section properties (Ze and Kf) when parts of the 

section are slender. 
 52808 An incident was resolved for concrete frame design using the ACI 318-08 and ACI 318-11 codes to 

correct the following reporting issues: (a) the reported values As(Top) and As(Bot) for the capacity 

shear calculation were incorrect, (b) the reported value vc was actually phi*vc and now the heading 

has been updated to reflect the reported value, and (c) the value phi*vnmax is now reported instead 

of vnmax. All calculations using these values were correct, and no other results were affected. 

 53660 

55162 

An incident was resolved for steel frame design using the AISC 360-05 code in which Omega0 

value specified in the design overwrites for a member was correctly being used in the design, but 

the reported value of Omega0 was always that from the design preferences rather than the design 

overwrites. If Omega0 was not specified as an overwrite for a given member, then the value in the 

preferences was used and the reported value was consistent. In either case, the design results were 

correct. 



SAP2000 v16.0.0 2013-09-10 Page 16 

* Incident Description 

 54006 An incident was resolved for steel frame design using the Indian IS 800:2007 code where the design 

was not checking the individual action equations in Sections 6.1, 7.1.1, 8.2. The interaction 

equations given in Sections 9.3.1.1, 9.3.1.3, 9.3.2.1, and 9.3.2.2 were being checked, as appropriate, 

depending upon the section type and section class (Class 1, 2 and 3). However, in certain rare and 

extreme cases the individual action checks may govern. This has been corrected and the output has 

been improved to provide more information.  

 54350 An incident has been resolved for steel frame design using the AISC 360-05 code where the KL/r 

ratios for the braces in OCBF frames of chevron configuration were not being reported as exceeding 

the code-specified limit in cases where the limit was actually exceeded. This error did not affect 

OCBFI frames. 

 54589 An incident was resolved for steel frame design where the section classification shown in the 

database tables could be incorrect. However, the classification shown in the design details by right-

clicking on a member was always correct, and the design results were consistent with that 

classification. No other results were affected in the database tables. 
 54825 An incident has been resolved for steel frame design using the Eurocode 3-2005 code in which an 

exception (runtime error) could occur while calculating the effective section properties of Class 4 

Double Angle sections under certain stress conditions. The stress condition occurred when (a) the 

minor axis moment was significant, (b) the stress at one of the tips of the flanges was identically 

zero and the stress at the other tip was compression under axial load plus minor-axis bending only. 

The error did not affect Double Angle sections for classes 1, 2, and 3.  

 55006 An incident was resolved that corrected several minor issues with Chinese frame design: 

(1) The graphical display of steel frame design results would indicate strength failure with the color 

red, but stability failure was not shown in red. The design details were correct, and no results were 

affected. 

(2) For steel frame design details, members that are too slender cited the code clause GB50017 

5.3.8, whereas they should have cited clause GB50011 8.3.1 and 8.4.2. No results were affected.  

(3) For concrete frame design, the design details reported the material strength and elastic modulus 

from code equations rather than from the material definition. No results were affected. 

(4) Redundant design load combinations that include seismic load cases may be generated if no 

vertical seismic loading is present. No results were affected. 

 55283 An incident was resolved for concrete frame design using the Eurocode 2-2004 code where the 

minimum reinforcement requirement for beams (EC2 9.2.1.1(1)) was being enforced for both the 

compression and tension sides, while it is only required for the tension side. 

 56356 An incident was resolved for concrete frame design using the TS 500-2000 code where the 

maximum compression limit for column design was always enforced as "0.5 fck Ac". The "0.5 fck 

Ac" limit is only applicable to load combinations that contain seismic loading; other load 

combinations should use the higher limit of "0.6 fck Ac". This has been corrected. The design 

results were always conservative for gravity combinations. 

 56982 An incident was resolved in the steel frame K factor calculation for the braced condition in which 

the sum of column stiffnesses becomes zero for some rare cases. This caused a runtime error.  

 
Results Display and Output 
Incidents Resolved 

* Incident Description 

 29010 An incident has been resolved where two minor display issues that did not affect results have been 

corrected: (1) When deflected shape was shown in two or more windows, the cursor would 

sometimes snap to the wrong points. (2) The Lock/Unlock tool button sometimes did not show 

when re-opening the application. 

 36447 An incident was resolved for steel frame design using Canadian code CSA S16-09 where not all 

tables are displayed when using the Tabular Data button of the design details display after right-

clicking on a member, although the same tabular results are available using the display or export of 

database tables. 



SAP2000 v16.0.0 2013-09-10 Page 17 

* Incident Description 

 38304 An incident was resolved where an error message was generated when trying to plot the deformed 

shape for a moving load case when no bridge results were requested to be calculated for any moving 

load case. Now the plot will show zero response with no error messages. Similar error messages 

were obtained for displaying other response quantities (reactions, frame forces, shell stresses, etc.) 

for which none had been requested. 

 38351 

52342 

An incident was resolved where an exception (runtime error) was generated when displaying frame 

forces for a model that contained a nonprismatic frame section property having a zero length 

segment. Zero-length segments are not valid for nonprismatic frame sections, and they will now be 

deleted when detected. 

 40467 

43175 

49829 

An incident was resolved where frame forces and stresses could not be displayed graphically or in 

database tables for frame objects with nonprismatic precast concrete frame section properties. These 

particular results were not available for display, but no other results were affected. 

 42139 An incident has been resolved where the detailed shell stress results plotted by right-clicking on a 

shell object were blank when viewing continuous stress contours for the model. This did not occur 

when viewing discrete stress contours, which is the default. No results were affected. 

 42178 An incident was resolved where certain loads applied directly to restrained joints in the first step of 

a nonlinear static load case were not included in the reported joint reactions or base reactions. Such 

loads include joint forces and ground accelerations, as well as loads applied to plane, asolid, solid, 

and link elements. Loads applied to frame and shell elements were not affected. This was a 

reporting error only. The applied loads were omitted from the reported reactions, but no other 

structural response (displacements, forces, stresses) or behavior was affected. Design was not 

affected. 

 43132 

44718 

An incident was resolved where an error message was generated when trying to display the cable 

force response in a model that had no frame section properties defined. No results were affected. 

 43222 An incident was resolved where numerical values in the printed output may have shown round-off 

error due to formatting the values to the specified number of decimal digits before converting for 

the specified display units. Instead, the values should have first been converted to the display units, 

then formatted to the specified number of decimal digits. The effect on the printed output was small. 

Values shown using the command Display > Show Tables, and results printed or exported from this 

display were properly converted and formatted and therefore did not have this problem. 

 43428 An incident was resolved where "Auto P" hinges were incorrectly labeled as being "Auto M3" on 

the Hinge Results form that is obtained using the command Display > Show Hinge Results. No 

results were affected, and the labeling was correct in other locations. 

 44498 An incident was resolved where the display of plot functions could become unresponsive (hang) 

when multiple functions were displayed at the same time. The functions included joint response and 

generalized displacements, and the generalized displacements were listed before and joint functions. 

No results were affected. 

 45146 An incident was resolved where undocumented numbers were displayed next to frame nonlinear 

hinges when plotting the deformed shape for nonlinear load cases when the option to show the wire 

frame (undeformed shape) was activated. These numbers represented the hinge state and status, but 

were not intended to be plotted. They are now disabled. 

 45391 An incident was resolved for steel frame design using the AISC 360-05 code where the D/C ratio 

reported for box/tube and pipe sections, when plotted on the screen, did not always match the value 

shown in the right-click details and in the tables. The correct values were presented in the details 

and tables; only the graphical display was incorrect. This error occurred for box/tube and pipe 

sections subjected to significant torsion. 

 48901 An incident was resolved where the various commands under File > Capture Picture on the Display 

Plot Function Traces form did not produce any output. No results were affected. 

 50769 An incident was resolved where area objects did not move from their undeformed shape when 

displayed in a video file (*.avi). No results were affected. 

 51142 An incident was resolved where displacement contours and principal stress arrows were incorrectly 

superimposed on the same plot after both had been displayed independently. 
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* Incident Description 

 53821 An incident was resolved where section-cut groups created by drawing and saving a section cut 

including area objects that were auto-meshed and that also had edge constraints assigned did not 

always include the effect of the edge constraints when reporting the section cut response in database 

tables. The section-cut response reported directly on the section-cut form after drawing was not 

affected. 

 54342 

55117 

An incident was resolved where moving the mouse over the structure did not show the numerical 

values when displaying the principal shell stresses Smax and Smin, forces Fmax and Fmin, or 

moments Mmax and Mmin as arrows. No results were affected. 

Database Tables 
Incidents Resolved 

* Incident Description 

 33565 An incident was resolved where the Steel Frame Design Overwrite data had gotten corrupted in 

certain models and was affecting the analysis results by changing the analysis section. The results 

were consistent with the model. This condition was being detected when the model was opened, and 

a warning message was displayed, but the corruption was not corrected. Now this data will be 

corrected when detected, but the model should still be reviewed by the user to make sure the correct 

sections are assigned to frame members. This was a rare occurrence. 

 35079 An incident has been resolved where the units reported using the Advanced Report Writer could be 

incorrect when the units had been changed from the model's database units and using a saved named 

report. 

 38699 An incident was resolved where the graphical user interface became unresponsive after using 

interactive database editing for the tables "Generalized Displacement Definitions 1 - Translational" 

and "Generalized Displacement Definitions 2 - Rotational". No results were affected. 
 43714 An incident was resolved where editing, displaying, or exporting to Access the table "Area Section 

Assignments" for a model that contained area objects with "None" assigned as the section property 

could generate an error message and result in the table being incomplete. In addition, importing the 

tables "Area Section Assignments" or "Frame Section Assignments" with the Section name set to 

"None" would result in the section being set to the default section name rather than to "None". The 

default section is the first section defined in the model. 

 44650 An incident was resolved where the import of files that had Notes fields exceeding 255 characters 

would fail. Now any files with Notes fields exceeding 255 characters will have those fields 

truncated to 255 characters during import. 

 45174 An incident has been resolved where an error is generated when exporting to Excel the database 

table "Functions - Response Spectrum - Italian NTC 2008". This is occurring because the name of 

the worksheet exceeds the limit of 31 characters for Excel. No results are affected. 

 50789 An incident was resolved where the buckling mode numbers were not shown in the database tables 

for analysis results, such as joint displacements, reactions, frame forces, section cuts, etc. Results 

were not affected. 
 53894 An incident was resolved where the units shown for the participation factors in the table "Modal 

Participation Factors" were given as [F-T^2] for translational degrees of freedom (DOF), and as [F-

L-T^2] for rotational DOF, whereas the units should be [F-L] for all DOF. The values shown in the 

table were correct in the database units of the model, but the translational values could be incorrect 

for other length units. Database units are those in effect when the model is first created. This error 

had no effect on any other results. 

 54061 An incident was resolved in which the database table of the design overwrites for the Eurocode 3-

2005 steel frame design code did not include all of the overwrite values. This did not affect the 

design, but it did mean that if a model was exported to a text, Excel, or Access file and then 

reimported, the missing overwrites would be reset to default values. In that case the design results 

would agree with the model as imported. 

 54558 An incident was resolved where the table for joint reactions was not available or generated errors 

when displaying for models that were supported solely by one-joint link objects. 
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* Incident Description 

 56780 An incident was resolved where the database table format file could not be read for certain 

Windows regional settings different from U.S.A. When this occurred, an error message was 

generated when trying to create a report or change to a different database table format file. 

Application Programming Interface 
Incidents Resolved 

* Incident Description 

 36280 An incident was resolved where the Open API function SapModel.FrameObj.SetOutputStations 

using the option "Minimum Number of Stations" had no effect on the model. Results were not 

affected. 

 37311 An incident was resolved in the Open API where using certain editing functions when the graphical 

user interface is minimized will generate an error message and the requested action will not be 

performed. Results were not affected. 

 41377 An incident has been resolved for the Open API function SapModel.PropLink.GetMultiLinearPoints 

where the function would fail and return a non-zero error code in the case where more than one 

degree of freedom had a multi-linear force-deformation relationship defined for the given link 

property. No results were affected. 

 44977 An incident was resolved where the OpenAPI function SetStageData_1 would return an error code 

and not perform the expected function when trying to set a staged-construction operation that 

applied a named set for frame property modifiers, area property modifiers, or frame releases. No 

results were affected. 

 45550 An incident was resolved that improved the documentation for the Open API (OAPI) help file for 

the source code of Example 5 (Visual C++ 2005). In particular, the instructions for the example 

code now mention the need to register the following two files that are part of the SAP2000 

installation: CSIMDIForm.dll and CsiGo_g.dll.  
 47746 

56308 

An incident was resolved that corrected documentation errors for the Open API (OAPI) help file for 

the source code of Example 3 (Visual C# 2005). In particular the references should be to the 

SAP2000 DLL file rather than to the SAP2000 EXE file. Other errors in case and syntax have been 

corrected. 

 51527 An incident was resolved for the Open API in which the following functions often returned a non-

zero error code and an empty list of function names: cDesignAluminum.GetComboStrength, 

cDesignAluminum.GetComboDeflection, cDesignColdFormed.GetComboStrength, 

cDesignColdFormed.GetComboDeflection, cDesignConcrete.GetComboStrength, 

cDesignSteel.GetComboStrength, and cDesignSteel.GetComboDeflection. No results were affected. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 37151 An incident was resolved where the material unit weight and modulus were set to incorrect values 

when these values were defined by reference to a type of material instead of explicit numbers in the 

STAAD file, and the STAAD file was in units others than pound-inches. When this occurred, the 

results agreed with the model. 

 46782 

48593 

An incident has been resolved for the export to Perform3D Structure if the model contains 

diaphragm constraints and/or area load assignments. The diaphragm constraints issue was due to an 

error in the OAPI function cConstraint.GetDiaphragm() in that failed to return the data. This OAPI 

issue is not specific to the Perform3D export and could therefore affect other third party 

development. 

 47276 An incident was resolved for the StruCAD*3D import of the LOAD JOIN card, in which MY or 

MZ loads were incorrectly imported if assigned. Results agreed with the model as imported. 



SAP2000 v16.0.0 2013-09-10 Page 20 

* Incident Description 

 49476 An incident was resolved for the export of IGES files where the header always defined the length 

units as inches regardless of the actual units used. In addition, the nodal coordinates were 

sometimes rounded to the nearest whole number. This incident was already resolved for SAP2000 

v15.2.0 but was inadvertently omitted from the Release Notes. Only versions prior to v15.2.0 were 

affected. 
 53444 An incident was resolved that addressed several issues with the import of STAAD files: (1) STAAD 

Reference Load specifications were not recognized and not processed (2) STAAD Repeat Load 

specifications were recognized but not processed (3) LX and LY were not recognized as valid 

STAAD pressure and trapezoidal element load direction specifications. (3) A dash character at the 

end of a line in the input file was being interpreted as a line continuation, even when it was not 

preceded by a blank space. It is now interpreted as a line continuation only when it is preceded by a 

blank space. 
 57876 An incident was resolved that addressed several issues with the CIS/2 file import and export: (1) If 

the CIS/2 file was written in feet units and the file included more than one CIS/2 

global_unit_assigned_context entity then the joint coordinates would not import correctly. (2) If 

column orientations in the CIS/2 file were specified as angles in degrees rather than as vectors then 

the column orientation would not import correctly. (3) If force units chosen in SAP2000 were 

kilonewtons then the CIS/2 file exported would have the force units undefined. (4) Error reporting 

for the import of CIS/2 files has been improved. 

Documentation 
Incidents Resolved 

* Incident Description 

 40301 An incident was resolved where the Help topic related to "Named Views" was pointing to an 

obsolete menu command. 

 41167 Minor documentation errors have been corrected in the Open API documentation. These are 

documentation errors only and do not affect the behavior or results of the product. These include: 

(1) PropArea.GetShell_1() call had the syntax for the depreciated call, and the example was also 

using the depreciated call. (2) PropMaterial.AddMaterial() call was not documented. (3) 

SapObject.SapModel.PropMaterial.SetOConcrete_1 & GetOConcrete_1 had the following 

parameter which was not present in the actual list of arguments: eFu: The effective tensile stress. 

[F/L2] This argument was removed from the documentation. (4) 

SapObject.SapModel.PropMaterial.GetORebar() call was moved from “Definitions->Properties-

Material” to “Obsolete Functions” branch in OAPI documentation since there’s a newer version 

(GetORebar_1()). (5) For SapObject.SapModel.PropLink.SetGap() call, the documentation for the 

argument “dis” was given as “c(*) = xxx” instead of “dis(*) = xxx”. 
 45496 An incident has been resolved in the Help file describing the default orientation of the local axes for 

a horizontal area object. The help file stated that the local 2 axis is parallel to the global X, whereas 

it is the local 1 axis that is parallel to X. No results are affected. 

 45672 

45673 

A documentation error has been corrected where the Concrete Frame Design manual for the code 

HK-CP-04 included Appendix D from the ACI 318 design code. No results were affected. 

 45986 A documentation error has been corrected for the "Steel Frame Design Manual" for code "AISC 

360-05/IBC 2006" in which the inequality sign in Eqn. AISC H1-1a, H1.3a was reversed. It has 

been corrected from less-than-or-equal to greater-than-or-equal. This was a documentation error 

only. The design results were correct. 

 46131 The Help file has been updated to remove the Export SASSI House Input Form topic, as this is not 

applicable to this version of SAP2000. Although the command Export > SASSI House File is 

available, this operation does not use any form (dialog box). 

 46618 A documentation error was corrected for the "CSI Analysis Reference Manual" where the node 

ordering shown for the quadrilateral shell element in Figures 31, 35 and 40  switched the locations 

of joints j3 and j4. 
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* Incident Description 

 47474 An incident about a documentation error was resolved in the Open API help file where the example 

for the function SapModel.Results.JointReact uses the function JointDispl instead of JointReact. No 

results are affected. 

 50664 A documentation error was corrected in the "Automated Lateral Load Manual", topic "2005 

Eurocode 1 (EN 1991-1-14) Wind Loads", where the formula for calculating the terrain factor was 

presented as kr = 0.19 [z0 / z0,II], but it should be kr = 0.19 [z0 / z0,II] ^ 0.07. This was only a 

documentation error. No results were affected. 

Miscellaneous 
Incidents Resolved 

* Incident Description 

 37684 An incident was resolved where the automated Excel Verification spreadsheet, would in certain 

instances, fail to fill the results for Example 1-019 into the spreadsheet. This did not affect the 

accuracy of the actual calculations for the example or any other model. 

 

 


